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Saved Searches
A saved search is a reusable search definition, that can have many advanced search filters and results
display options. If you have the Publish Search permission, you can share search results with other
users. Saved search results provide reporting and tracking and can serve as the basis for business
analysis and strategic decision-making.

You may decide you want to save a search when you are defining a search, or after you have run a
search. Or you may know in advance that you want to create a saved search rather than a search.
When you have decided to save a search, and you have opened a saved search page, you can define
the saved search. For step-by-step instructions, see Defining a Saved Search.

As you are defining a saved search, you can specify that results be sent automatically by email to
selected recipients, if you have the Publish Search permission. Email messages of search results can be
sent at scheduled intervals and/or when results are updated, without you needing to rerun the search.
See Saved Search Email.

After you have defined a saved search, you and other users designated as audience members can
access the search by title from NetSuite saved search menus. For information, see Accessing a Saved
Search.

Each saved search has an execution log listing the users who have run or exported the saved search in
the past 60 days, and the dates and times of each execution. See Auditing Saved Search Execution. An
audit trail is also available for tracking changes to saved searches. See Audit Trail for Saved Searches,
Reports and Schedules.

Your account administrator grants general search permissions and search access by record type that
enable you to create and run saved searches. Your level of search permissions determines whether you
can email, export, and persist saved search results, whether you can share saved searches with other
users, and whether you can view saved search execution logs. For more information, see Permissions
for Searches.

If your saved search takes a long time to run, you may consider setting up a scheduled email or
persisting search results. For more details, see Enabling Saved Search Scheduled Email and Persisting
Search Results. If you have the Application Performance Management SuiteApp installed in your
account, you can also use the Search Performance Analysis dashboard to view search performance
details. For more information, see the help topic Analyzing Search Performance.

Saved search results can be linked to and displayed from dashboard portlets:

■ You can add links to results pages in the Shortcuts portlet. See Creating Shortcuts to Saved Search
Results.

■ You can display detailed results in a Custom Search portlet. See Displaying Saved Search Results in
Dashboard Portlets.

■ You can use other portlets to display multiple saved searches on your home page. See Displaying
Multiple Saved Searches on Your Home Page.

■ You can display summary values from saved search results by defining saved searches as custom
KPIs. See the help topic Custom KPIs . Custom KPIs can be displayed in the following portlets:

□ Key Performance Indicators Portlet. See the help topic Adding a Custom KPI to the Key
Performance Indicators Portlet

□ KPI Scorecard Portlet. See the help topic Using a Custom KPI in a KPI Scorecard.

□ KPI Meters. See the help topic KPI Meters.

□ Trend Graphs. See the help topic Trend Graphs.

■ You can add counts of and links to results in the Reminders portlet. See the help topic Creating
Custom Reminders.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_1508294507.html
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You also can use saved searches in the following ways:

■ You can designate results to be used as the dashboard view, list view, and/or sublist view of the
selected record type. See Using a Saved Search as a View.

■ You can designate a search's filtering and display options to be used on forms for the selected
record type. See Defining a Saved Search as a Preferred Search Form.

■ You can publish the results of public saved searches to your website. Users with the Publish Search
Permission can make saved searches public. For more information, see the help topic Adding a ‘Tell
A Friend' Link.

Defining a Saved Search
To create a saved search, you need to access a saved search definition page for a selected record type.

You can access a saved search definition page in any of the following ways:

■ Go to Reports > Saved Searches > All Saved Searches > New and select the record type for the saved
search.

You can also use Transactions > Management > Saved Searches > New or Lists > Search > Saved
Searches > New.

■ On a simple or advanced search definition page, click the Create Saved Search button.

■ On a search results page, click the Save This Search button.

■ For an existing saved search, go to Reports > Saved Searches > All Saved Searches, and click Edit
next to the saved search you want to redefine.

To define a saved search:

1. On a saved search definition page, enter a title for the saved search.

Try to make the title concise and meaningful, as it may appear in menu links, as a dashboard
portlet header, or as a custom KPI name.

2. If you are editing an existing saved search, you can use the Owner dropdown menu to change
the search owner. By default, the user who created the saved search is the owner of the search.

■ The Owner dropdown menu is available to administrators and, if the search is public or has
an audience defined, to the search owner.

Warning: If the owner of a scheduled saved search is changed to another user who
has never previously scheduled a saved search, the search email is no longer sent at the
scheduled time. For scheduled email for this search to resume, the new owner must log
in with the appropriate role and resave the search.

3. If you want the search to be available to all users, check the Public box. If not, you can define a
more limited audience on the Audience subtab.

■ The Public check box and the Audience subtab are available only to administrators and
to other users with at least Create level of the Publish Search permission, a Lists type
permission.

■ Making a saved search public means all users can run the search and see its results. Even for
public searches, only administrators and the search owner, meaning its creator, can edit the
search. To allow other audience members to edit saved search definitions, you need to check
the Allow Audience to Edit check box on the Audience subtab.

■ Customers, vendors, and partners other than advanced partners generally do not have
access to saved searches, even those that are defined as public. If these types of users do
gain access to a published saved search, they can run the search only if they have permission

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2603455.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2603455.html


Defining a Saved Search  100

Search

to view the search record type, and the search returns only their own records. However, if
your saved search contains sensitive information, it is strongly recommended that you do not
make it public, and instead use the fields on the Audience subtab to define a more limited
audience.

4. Check any of the following boxes, if you want search results to be available as views for list pages
of the searched record type.

■ Available as List View

■ Available as Dashboard View

■ Available as Sublist View

If you want these views available to a subset of the audience, leave these boxes blank, and check
the corresponding boxes on the Roles subtab. For more information, see Using a Saved Search
as a View.

5. If you want to be able to link to search results from the Reminders portlet, check the Available
for Reminders box. For more information, see the help topic Creating Custom Reminders.

6. If you want this search to be available in menus, check the Show in Menu box.

7. On the Criteria subtab, define criteria to filter saved search records. These criteria can include
dynamically calculated field values, including join fields; formulas containing SQL functions, as
well as AND/OR expressions. For information, see:

■ Advanced Search Criteria Filters

■ Formulas in Search

■ Search Formula Examples and Tips

■ Using And/Or Expressions in Search Criteria

■ Related Records Fields Available for Advanced Searches

Note: To use a saved search as a custom KPI that displays results for multiple date
ranges, you must not define a date field as a filter on the Criteria subtab. For additional
requirements for this type of custom KPI, see Notes on Using Saved Searches as Custom
KPIs.

8. On the Results subtab, define display options for saved search results, including:

■ In the subtab header:

□ Sort order of results records, or rows

□ Output type, meaning overall format for the results page

□ Show Totals option to display a total line on results page

□ Run Unrestricted option to make search results available to users who would normally
be restricted from seeing the underlying records. Note that users without the correct
permissions will still be unable to view the search results. See the help topic Permissions
and Restrictions

Important: The Run Unrestricted option is not applied to time and expense
searches by users that have roles with the Restrict Time and Expenses option
enabled. Employees using a role with the Restrict Time and Expenses option
enabled cannot enter expense reports or time transactions on behalf of other
employees and their reports and searches do not return any time or expense
transactions entered by other employees. The Restrict Time and Expenses option
for a role overrides the Run Unrestricted option for a search.

□ Disallow Drill Down option to prevent users of unrestricted search results from drilling
down to more detailed data

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N585781.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_3781107123.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_3781107123.html
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□ Max Results option to limit the number of records displayed in results

□ My Preferred Search Results option to apply search settings to quick search results pages
(See Defining a Saved Search as Preferred Results.)

■ On the Columns subtab:

□ Order of columns

□ Fields and/or formula calculations to be displayed as columns on the search results page,
including:

□ Custom labels for one or more fields

□ Summary types to group one or more fields' values (including group, sum, count, min,
max, and average)

□ Functions to be applied to one or more fields' values

■ On the Drill Down Fields subtab (if available):

Note: This subtab is available if you have the Presentation Categories permission, a
Lists type permission. You do not have to be an administrator.

□ Fields, including join fields, to be displayed when a viewer of search results drills down on
a record

□ The order in which drill down fields are displayed

□ Custom labels for displayed drill down fields

For more information, see Search Results Display Options.

9. On the Available Filters subtab, define fields or formulas to appear as filters on the results
pages. For information, see Selecting Available Filters for Saved Searches.

Note: To use a saved search as a custom KPI that displays results for multiple date
ranges, you must define a date field as an available filter. You do not need to check the
Show in Filter Region box. For additional requirements for this type of custom KPI, see
Notes on Using Saved Searches as Custom KPIs.

10. (If you have at least the Create level of the Publish Search permission) On the Audience subtab,
define the users who can run the saved search and view its results, and whether they can edit its
definitions. For information, see Defining Audiences for Saved Searches.

11. (If you have at least the Create level of the Publish Search permission) On the Roles subtab,
define the users who will see search results as their view of the selected record type, in lists,
sublists, dashboard list portlets, forms, and quick search results. For information, see Using a
Saved Search as a View and Defining a Saved Search as a Preferred Search Form.

12. (If you have at least the Create level of the Publish Search permission) On the Email subtab,
you can send search results email, as alerts triggered by record changes, and/or according to a
schedule.

■ Check the Send Alerts When Records are Created/Updated box to send email alert
messages when saved search results are added or updated, and then define recipients for
alerts. For information, see Enabling Saved Search Email Alerts.

■ You can make alerts available to users other than defined recipients by checking the Public
and Allow Users to Subscribe boxes. Then users can go to Home > Set Preferences and
elect to receive alerts. For information, see Setting User Preferences to Receive Saved Search
Alerts.

■ Check the Send Emails According to Schedule box to set up the search to be run on a certain
date or interval, with results emailed to yourself and/or other users. For information, see
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Enabling Saved Search Scheduled Email. Scheduling is a good option for saved searches that
take a long time to run.

For more information, see Saved Search Email.

13. On the Highlighting subtab, you can set up visuals to draw attention to selected individual or
aggregated results. Highlighting options include images, colored text, background colors, and
bold text. For information, see:

■ Highlighting Search Results

■ Adding a Legend to Highlighted Search Results

14. After you have completed saved search definitions, you can do the following:

■ Click Preview to review search results without saving the search definitions.

■ Click Save to save search definitions and make the search available to be run by yourself and
other audience members.

□ Click Save & Run to save search definitions and review search results.

□ Click Save & Email to save search definitions and email results to the recipient(s) you set
up on the Email, Specific Recipients subtab. (available only if you have the Publish Search
permission)

For information about viewing saved search results, see Displaying Saved Search Results on Your
Dashboard.

Notes on Using Saved Searches as Custom KPIs
For a saved search to be used as a custom KPI that displays results for multiple date ranges in the Key
Performance Indicators portlet, a KPI scorecard, a trend graph, or a KPI meter, the search definition
must:

■ Not include any date fields defined as filters on the Criteria subtab

■ Have only field with a summary type (such as group, sum, or count) defined on the Results subtab.

■ Have a date field defined as an available filter on the Available Filters subtab.

For more information, see the help topic Custom KPIs.

Selecting Available Filters for Saved Searches
The filters you define on the Criteria subtab of a saved search page exclude records from search
results. On the Available filters subtab, you can define additional, optional filters that search viewers
can use to further limit results, or that other system functions like KPI scorecards can use internally to
calculate summaries and comparisons of results.

Available filters can appear as dropdown menus or multi-select boxes of field values in the filter region
of search results, and viewers can select values to dynamically apply filtering to search results. You can
define a custom label for each available filter's dropdown list or multi-select box.

Note: To use a saved search as a custom KPI that displays results for multiple date ranges,
you must define a date field as an available filter. You do not need to check the Show in Filter
Region box. For additional requirements for this type of custom KPI, see Notes on Using Saved
Searches as Custom KPIs.

To define available filters for a saved search:

On the Available Filters subtab of the saved search page:

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N609047.html
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1. To define a field to be available as a dynamically set filter on search results, select the field from
the Filter dropdown list.

Fields from the selected record type and join fields from related record types are listed in the
Filter dropdown list.

2. For each filter that has non-numeric values, you can check the Show in Filter Region box to
display choices of field values in the filter region of search results, so that search viewers can
dynamically filter results.

By default, field values are displayed in a dropdown menu where viewers can select one value at
a time.

Please note that there are limitations for certain filters included in the filter region. For details,
see Limitations for filters displayed in the filter region.

3. When the Show in Filter Region box is checked, you can check the Show as Multi-Select box
to cause values to be displayed in a multi-select dropdown list, enabling you to select multiple
values to filter search results.

■ In search results page filters, values are by default displayed in a single-select dropdown list.

■ The Show as Multi-Select option does not apply to available filters shown on search
forms. Values for an available filter on a search form are always displayed in a multi-select
dropdown list.

4. For each filter, you have the option of defining a custom label.

A transaction saved search with the Type field defined as an available filter and the Show in Filter
Region box checked displays a Type dropdown list on the results page, where a viewer can choose one
type of transaction at a time to dynamically filter search results.

If the Show as Multi-Select box is checked, a multi-select box displays in the filter area so that you can
choose multiple Type values to filter search results.
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Limitations for filters displayed in the filter region

■ If you add a date filter that has already been set on the Criteria tab and select the Show in Filter
Region option for this field, the field in the filter region will inherit the date settings specified on the
Criteria tab. For example, if you added a Date Created field on the Criteria tab and set it to before
12/31/2014, the date filter in the filter area will display results that were created before any other
date that you choose in the filter area.

■ If you add a Period filter that has already been set to a specific period on the Criteria tab, the
Period field in the filter region will not contain that specific period, and it will neither be available in
the filter's dropdown list. For example, if the Period field is set to May 2013 on the Criteria tab, the
Period filter in the search results will appear blank, and May 2013 will be not listed as an available
option for this filter.

Defining Audiences for Saved Searches
If you are an administrator or have at least Create level of the Publish Search permission, you can use
the Audience subtab on saved searches to define a list of users who can run the search and view its
results. You also have the option of making the search available to all users by checking the Public box.
For information, see Making Saved Searches Public.

Only users who are members of the defined audience and account administrators see the saved
search on search related lists. Setting the audience for a saved search also restricts its appearance
in list views, sublist views, dashboard list portlets, and preferred search forms. You set up these
preferences on the Roles subtab. By default only administrators and the owner of a saved search,
meaning its creator, can edit the search. Audience members cannot edit saved search definitions
unless you check the Allow Audience to Edit check box.

Customers, vendors, and partners other than advanced partners generally do not have access to
saved searches, even those that are defined as public. If these types of users do gain access to a
published saved search, they can run the search only if they have permission to view the search record
type, and the search returns only their own records. However, if your saved search contains sensitive
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information, it is strongly recommended that you do not make it public, and instead use the fields on
the Audience subtab to define a more limited audience.

To define an audience for a saved search:

1. When defining or editing a saved search, click the Audience subtab.

2. If you want to allow the audience to make changes to search definitions, check the Allow
Audience to Edit box.

■ If this option is enabled, the audience can make changes and save the search with the same
name.

■ If this option is not enabled and the audience makes changes, they can do a “save as” to save
the search with a different name.

3. In the fields provided, choose an audience for your search results. You can select options from
any or all of the following audience types.

For each of the audience types, you can select multiple options by holding down the Ctrl key as
you are making your selections.

■ Roles – Select one or more roles.

To make the search available to all users in your account, check the Select All box.

Note: If your account contains a large number of roles, they may not be in a
dropdown list, making it difficult to select multiple roles. You can change the roles list
to display in a dropdown list by increasing the number set for Maximum Entries in
Dropdowns at Home > Set Preferences, on the General tab.

■ Departments – Select one or more departments.

■ Subsidiaries (If Available) – Select one or more subsidiaries.

■ Groups – Select one or more groups.

■ Employees – Select one or more employees.

To make the search available to all employees, check the Select All box.

■ Partners – Select one or more partners.

To share with all partners, check the Select All box.
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Important: If you choose both role and department options, a user must belong to one of
the selected roles AND one of the selected departments to access the search. If you choose any
other combination of options, a user needs to belong to only one type of option OR the other,
not both, to access the search.

Making Saved Searches Public
To define a saved search as public, check the Public box near the top of the saved search page. This
check box is available only to administrators and to other users with the Publish Search permission,
a Lists type permission. If you are unable to check this box or you do not see it, you do not have the
ability to make saved searches public.

Public saved searches can be published in your website, and they are available to be run by everyone
with access to your account. The use of public saved searches can save time for employees and ensure
that all users conduct searches using the same criteria. Also, if you want a saved search to be available
for inclusion in a NetSuite bundle, you must make it public.

By default, only administrators and a saved search's owner (creator) can edit its definitions. Users can
run and view results of a public saved search, but they cannot edit its definitions and resave it with the
same name, unless the Allow Audience to Edit box is checked. Users can, however, edit the search and
click the Save As button to save the search with a different name.

Note: You can let users subscribe to email alerts of search results only if you already have
made the saved search public. For more information, see Enabling Saved Search Email Alerts.

Highlighting Search Results
Saved searches provide a variety of highlighting options you can use to call attention to selected search
result rows. You can highlight individual rows that meet defined conditions. If your search results
include grouped values such as counts, sums, and averages, you can highlight aggregated results that
meet defined conditions.

Available highlighting options include:

■ Images

■ Text colors

■ Background colors

■ Bold text

■ Description for a highlighting legend in the results page.

For information about highlighting search results, see:

■ Step-by-Step Instructions for Highlighting Results

■ Conditions for Highlighting

■ Summary Highlighting

■ Adding a Legend to Highlighted Search Results

Step-by-Step Instructions for Highlighting Results

1. When editing or creating a saved search click the Highlighting subtab.

2. On the Highlight If or Highlight If (Summary) subtab, click the Set Options icon next to the
Condition field to open a popup window.
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■ If you want to include expressions in the condition's filter(s), check the Use Expressions box.
For information, see Using And/Or Expressions in Search Criteria.

■ If you are creating a condition for summary results, select from the Summary Type dropdown
list. This selection must match the summary type defined for the field on the Results subtab.

3. In the popup, select a field or a formula to be used as filter for the highlighting condition.

Note: If you are creating a condition for summary results, make a selection from the
Summary Type dropdown list. This selection must match the summary type defined for
the field on the Results subtab.

■ To define a field value from the selected record type as a filter:

□ Select the field from the Filter dropdown list.

□ Click the Set Options button to open a popup where you can enter a value, and search
logic (if available), for the filter field.

■ To define a formula as a filter:

□ Select a Formula option from the Filter dropdown list.

□ Click the Set Options button to open a popup where you can enter the formula.

□ For more information about search formulas, see Formulas in Search.

■ To define a join field value from a related record type as a filter:

□ Select the related record type in the Filter dropdown list.

□ In the first popup that appears, select the join field from a Filter dropdown list.

□ In the next popup, enter a value, and search logic (if available), for the filter field.

□ For a list of related record types with join fields available for each record type search, see
Related Records Fields Available for Advanced Searches.

4. Repeat step 3 for each filter you want to apply as a condition for highlighting results. When you
have added all filters, click the Set button in the popup.

5. If you want to use an image to highlight results that meet the condition, select from the Image
dropdown list, or click the Icon next to this dropdown list and select an image from the popup
Icon Picker.

6. If you want to change the text color of each result that meets the condition, click the Select Color
icon in the Text Color column.

7. If you want to change the background color of each result that meets the condition, click the
Select Color icon in the Background Color column.

8. If you want to bold text for each result row that meets the condition, check the Bold box.

9. If you want to include a Legend in the footer of the Search, enter a Description for this highlight
condition. For more information about legends, see Adding a Legend to Highlighted Search
Results.

10. Click Add.

11. Repeat steps 2-10 for each highlighting condition you want to apply to the results of this search.

12. Click Save.

Conditions for Highlighting

You select the result rows to be highlighted by defining conditions on the Highlighting subtab of a
saved search page. You can define multiple conditions for each saved search; each condition can have
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its own associated highlighting options. A condition consists of one or more filters that are compared
with results values. Results that satisfy filter(s) meet the condition, and are highlighted according to the
options you set for that condition.

For example, you could create a condition for a saved customer report that would apply a green
background to all customers in San Francisco with a balance greater than $5000. You then could create
an additional condition that would highlight customers in San Diego with a balance over $5000 with a
blue background.

One row in a search result can meet more than one highlight condition. When multiple conditions
are met, highlighting depends on the order of highlight conditions. The first condition has the highest
priority. When the first met highlight condition doesn't use all highlight possibilities (Image, Text color,
Background color, Bold) then another condition is applied but for available criteria. If there are multiple
conditions, the search results will be highlighted using the order of the conditions. For example, if a
search result is a row with the following values.

Name Email

Adam No@nsmail.com

For this example, the user applies multiple condition in this order:

1. Name starts with ‘X’, Background Color is ‘Black’, Bold is ‘None’, Text Color is ‘White’, and Image
is ‘None’.

2. Name starts with ‘A’, Background Color is ‘Green’, Bold is ‘None’, Text Color is ‘None’, and Image
is ‘None’.

3. Email starts with ‘N’, Background Color is ‘Red’, Bold is ‘Y’, Text Color is ‘None’, and Image is
‘None’.

Nothing in the first condition applies to the search result. In the second condition, the search result
matches the criteria of ‘Name starts with A’ so the entire rows background is green. In the third
condition, the email does match the criteria of ‘Email starts with N’ so the background would be red,
however, in the second condition the criteria supersedes this criteria. The ‘Bold is Y’ criteria is a match
so the entire row has bold text.

Highlighting Using Greater Than or Magnitude Greater

The difference between the ‘Greater Than’ and ‘Magnitude Greater Than’ option is that the ‘Magnitude
Greater Than’ option highlights both compared periods whereas the ‘Greater Than’ option does not.
For example, if you compare sales for this period to last period and you use the ‘Magnitude Greater
Than’ as follows:

Highlight if = Magnitude Greater Than | Threshold = ‘amount’ | Period = All | Background Color =
‘color’.

The result for both periods are highlighted. If, however, you use the ‘Greater Than’ option, in this
example it will highlight the results for ‘This Period’.

Summary Highlighting

If you have defined a summary type for a field on the Results subtab of a saved search page, you can
set up highlighting of aggregated results for this field on the Highlight If (Summary) subtab of the
Highlighting subtab. Available summary types include count, sum, minimum, maximum, and average.
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For example, if you filtered a saved transaction search to include sales transactions, and defined a
summary type of Sum for the Net Amount field, you could highlight the names of customers with over
$100,000 total sales with a red background color.

Adding a Legend to Highlighted Search Results

You can add a legend to the footer of saved searches to help you identify the highlighted search
results.

1. When editing or creating a saved search, click the Highlighting subtab.

2. For each defined highlighting condition enter a description in the Description field.

For example, if you chose to highlight all customers with the 504 area code in yellow, you can
enter 504 area code as your description.

3. When the description is entered, click Done.

4. Click Save.

Marking a Search Inactive
You can mark a search inactive for any saved search that you own. By default, the creator of a saved
search is its owner.

To mark a search inactive:

1. Go to the list of your saved searches.

2. Make sure that the Show Inactives option is selected.

3. Check the Inactive box next to the saved search you would like to make inactive.

4. Click Submit.

Editing or Deleting a Saved Search
You can edit or delete any saved searches that you own. By default, the creator of a saved search is its
owner. You also can edit saved searches to which you have access, that are owned by other users. If the
search owner has checked the Allow Audience to Edit box for a saved search, you can edit it and save
it with the same name. If not, you still can edit the search, but you must do a “Save As” to save it with a
different name.
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Important: Only a saved search's owner and account administrators can delete the saved
search. Account administrators also have greater ability than other users to edit saved
searches. For information, see Administrator Access to Other Users' Saved Searches.

To edit a saved search:

1. Open a saved search definition page.

■ You can open a saved search by selecting it from a list of saved searches. Lists of saved
searches are available at Reports > Saved Searches > All Saved Searches, and at Lists > Search
> Saved Searches.

■ You can use global search to find a saved search. In the Search field in the upper right corner,
enter the prefix s: and the name of the search, as in the following example:

s:Custom Lead Search

2. To delete the saved search, click the Delete button, if it is available. (This button will only be
available if you are the saved search owner or an account administrator.)

3. Make changes to the saved search as desired.

■ For information on what you can define for a saved search, see the steps in Defining a Saved
Search.

■ If you want to undo changes at any point, click the Reset button.

4. After you have edited saved search definitions, you can do the following:

■ Click the Preview button to review search results without saving the search definitions.

■ Click the New Template button to create an advanced PDF/HTML template for printing the
saved search results. For more information, see the help topic Advanced Templates for
Printing Saved Search Results

■ Click Save As to save the changed search under a different name.

□ Click Save to save the changed search under the same name. (if available)

□ Click Save & Run to save the changed search and review results. (if available)

□ Click Save & Email to save the changed search and email results to the recipient(s) you
set up on the Email, Recipients from Results or Email, Specific Recipients subtabs. (if
available)

□ For more details on save options, see Accessing a Saved Search.

■ To create a custom template to use when printing results from this saved search, click New
Template. The New Template button is available if advanced PDF/HTML templates are
enabled for your organization. For more information about creating a custom template to
print results from this saved search, see the help topic Advanced Templates for Printing
Saved Search Results.

■ If server SuiteScript is enabled, click the Change ID button to change the search ID.

(NetSuite generates a default ID for each saved search you create. The default ID format
is customsearch#. If you are including calls to saved searches in scripts, you may want to
change this ID.)

Using a Saved Search as a View
You can define a saved search's definition to be available for views to all of its audience, and/or make
it the preferred view for that record type's lists. The search audience is defined by your settings in the
Public check box and the Audience subtab.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4823423235.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4823423235.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4823423235.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4823423235.html
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A list view is a definition of the records and fields to be displayed on a list page for a record type. A
sublist view is a definition of the records and fields to be displayed on a subtab list for a record type. A
dashboard view is a definition of the records and fields to be displayed in the List portlet for a record
type. These view definitions are based on saved searches, so the saved search definition page enables
you to reuse your search settings for list, sublist, and dashboard views.

Important: If the Use Expressions option is enabled for a search, inline editing is disabled in
list, dashboard, and sublist views based on the search. If you want inline editing to be available
for a view, ensure that the Use Expressions box on the Criteria subtab is not checked for the
search that filters view results. See Using And/Or Expressions in Search Criteria.

Making a Saved Search Available for Views
Each saved search page has a set of Available as View check boxes in the header. You can enable one
or more of these check boxes to make the saved search's definitions available for the audience to apply
to list views, sublist views, and/or dashboard list portlets of the selected record type.

■ If the Available as List View box is checked, users can select the saved search's title in the View
dropdown list at the bottom of list pages of the selected record type, to display records and fields
according to saved search definitions.

■ If the Available as Sublist View box is checked, users can select the saved search's title in the View
dropdown list at the bottom of lists of the selected record type on subtabs.

■ If the Available as Dashboard View box is checked, users can select the saved search's title in the
View dropdown list at the bottom of dashboard list portlets of the selected record type.

If a list, sublist, or dashboard List portlet does not include a View dropdown list, it means no saved
searches for that record type have been made available for that type of view. Do not use record type
names in search names.
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In addition to the View dropdown list, users can click Customize View to create their own custom search
to use as a custom view. See the help topic Working with List Views, Sublist Views, and Dashboard
Views.

Note: Account administrators can prohibit users with a specific role from using saved searches
as views, even if the Available boxes have been checked, by restricting that role to use of one
list view, sublist view, or dashboard view only. This setting is on the Searches subtab of the Role
record. See the help topic Customizing or Creating NetSuite Roles.

Defining a Saved Search as a Preferred View

The Roles subtab of each saved search page has a set of Preferred View check boxes. You can check
these boxes to apply the saved search's definitions to default views for lists, sublists, and/or dashboard
list portlets of the selected record type.

Use the global preferred view check boxes at the top of the subtab to set preferred views for all users,
based on public searches. The View dropdown list selection is sticky, which means it remembers the
last users selection. The user’s selection takes precedence over any existing or newly created preferred
view that may exist. For example, if a default view is added by an administrator, the default view will
not supersede existing individual users' preference of view displayed by default.

Use the check boxes in the List, Sublist, and Dashboard columns to set preferred views per role.

To set this saved search as the default list view for all users:

■ Check the Preferred List View box. This option is available when the Public and Available as List View
boxes are checked.

Note: The Preferred List view serves as a default value set by administrator for all users in a
company. Each individual user that possesses such a permission, may create her own search
and use it as a view which takes precedence over the company-wide preference for that user.

To set this saved search as the default list view for a subset of
users:

■ Check the List box for each role that should use this saved search as the default list view. This
option is available when the Available as List View box is checked.

To set this saved search as the default sublist view for all users:

■ Check the Preferred Sublist View box. This option is available when the Public and Available as
Sublist View boxes are checked.

To set this saved search as the default sublist view for a subset
of users:

■ Check the Sublist box for each role that should use this saved search as the default sublist view. This
option is available when the Available as Sublist View box is checked.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495842.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495842.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285937.html
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To set this saved search as the default dashboard view for all
users:
■ Check the Preferred Dashboard box. This option is available when the Public and Available as

Dashboard View boxes are checked.

To set this saved search as the default dashboard view for a
subset of users:
■ Check the Dashboard box for each role that should use this saved search as the default dashboard

view. This option is available when the Available as Dashboard View box is checked.

Note: Account administrators also may customize roles to set up a saved search as the
default list view, sublist view, or dashboard view for a record type, or restrict a role from using a
saved search as a list view, sublist view, or dashboard view for a record type. See the help topic
Customizing or Creating NetSuite Roles.

Defining a Saved Search as Preferred Results
Check the My Preferred Search Results box, on the Results subtab, to customize your quick search
results. All search settings are applied, including criteria, are applied to quick search results.

If you are an administrator or another user with the Publish Search permission, you can check boxes
on the Roles subtab to customize quick search results for other users.

■ To customize results for users assigned a selected role, check the Results box for that role.

■ To customize results for all roles, ensure the Public box is checked, and check the Preferred Search
Results box.

Note: The My Preferred Search Results option for a user overrides any preferred search
results set on the Roles subtab by other users.

For more information, see Quick Search Portlet.

Defining a Saved Search as a Preferred Search Form
By default, the simple search form for each record type displays a system-defined set of fields that
can be used as filters. To simplify your searches, you can apply your saved search's available filters
to be the only fields on this form. If you are an administrator or another user with the Publish Search
permission, you can define a preferred search form for other users too.

For details, see:

■ Setting My Preferred Search Form

■ Setting a Preferred Search Form for Other Users

Note: An alternate approach is to create a personalized search form rather than using a saved
search. See Personalizing a Search Form.

Be aware that account administrators also may customize roles to set up default search forms for one
or more record types per role. See the help topic Customizing or Creating NetSuite Roles.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285937.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285937.html
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Setting My Preferred Search Form

To set up your saved search to be used as your preferred simple search form, go to the Available Filters
subtab of the saved search definition page, add filter fields, and check My Preferred Search Form.

For example, you can set up the following search to be your preferred form for customers:

Your simple search form looks like this:
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Setting a Preferred Search Form for Other Users

The Roles subtab of each saved search page has a set of Preferred Form check boxes you can use
to apply the saved search's available filters to the simple search form, for some or all of the search
audience.

■ To use a saved search as the preferred form for all users, check Preferred Search Form.

You must first make the search public and add at least one filter to the Available Filters subtab,
before you check this box.

■ To use a saved search as the preferred form for a subset of the audience, check Form boxes for
specific roles.

Note: Your setting for My Preferred Search Form overrides Preferred Search Form settings
here.

Forms are the pages used to enter information into the NetSuite database. Setting preferred forms
for your employees lets you control the entry and transaction forms employees use to enter data. This
maintains consistency in your company and lets you capture the information that is most important to
your business.

Using a Saved Search as a Reminder
If a saved search's results drive your work tasks, you can add a count of results, with a link to the
details, to your dashboard Reminders portlet. This link, called a custom reminder, makes your
important task information readily accessible. After you check the Available for Reminders box on the
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saved search page, you can set up your Reminders portlet to include the new saved search reminder.
This reminder also is available to other users in the search audience.

Be aware of the following when you plan to use a saved search as a reminder:

■ The search title is displayed in the Reminders portlet, with the format: <number_of_results>
<saved_search_name>

Define a search title that makes sense as a reminder.

■ Custom reminders work best for saved searches that do not have results grouped by summary
types, because reminders are based on a count of the number of results, and only display when this
count is a non-zero integer.

If you set up a reminder for a saved search that groups results by a summary type other than a
count, the reminder does not display.

You can define a count for a field that has a summary type defined, to make the reminder display,
but the reminder result is affected by the grouping and may not include the total count of saved
search results.

You should check the Results subtab to see if the saved search includes any summary types. If it
does, it may be best to remove them, or to recreate the search without summary types.

For detailed steps and an example, see the help topic Creating Custom Reminders.

Using Saved Searches for Customer Center Lists
If you try to use a saved search to modify what is displayed for a Customer Center list, such as See All
Transactions or See Orders, the search definition is automatically modified to show the list as originally
defined. You cannot override the definition for these lists that are specifically designed for Customer
Center.

Instead of modifying searches, you can use permissions to control the visibility of Customer Center
lists. For example, to control the display of the See Orders link to displaying only invoices, you can
modify the role used by customers as follows:

■ Remove the Transactions : Sales Order permission.

■ Set the Transactions : Find Transaction permission to View level.

■ Set the Transactions : Invoice permission to View level.

Change of Sign for Expense Account Amounts in
Transaction Saved Searches
Before Version 2014 Release 1, saved searches handled expense accounts as credit accounts instead of
debit accounts. Consequently, transaction saved searches displayed positive amounts for credit posting
transactions and negative amounts for debit posting transactions. Note that this behavior impacted
saved searches only; it did not impact reports or accounting processes.

As of Version 2014 Release 1, saved searches handle expense accounts as debit accounts.
Consequently, transaction saved searches display positive amounts for debit posting transactions
and negative amounts for credit posting transactions. This change ensures that expense accounts are
handled and displayed consistently throughout NetSuite.

NetSuite recommends that you look at all of your transaction saved searches that include results
amounts associated with Expense accounts to review how these amounts are displayed as of Version
2014 Release 1.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N585781.html
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■ If there is a transaction saved search where you need to maintain the behavior that existed before
this release, you must edit the search to flip the sign of the impacted amount field(s) such as
Amount, Amount (Alt.Sales), or Amount (Gross).

■ You can flip the sign of an impacted amount field by replacing that field, for example Amount
(Gross), with a formula field like the following: DECODE({accounttype}, 'Expense', -1, 'Other Expense',
-1, 'Cost of Goods Sold', -1, 1) *{grossamount}.

The following table provides suggested formulas that yoou can use as a reference if you need to flip the
sign of impacted amount fields in your transaction saved searches.

Result Field Formula Field Suggested Formula

Amount {amount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{amount}

Amount (Alt. Sales) {altsalesamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{altsalesamount}

Amount (Alt. Sales Net) {altsalesnetamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{altsalesnetamount}

Amount (Foreign
Currency)

{fxamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{fxamount}

Amount (Gross) {grossamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{grossamount}

Amount (Net) {netamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{netamount}

Amount (Net of Tax) {netamountnotax} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{netamountnotax}

Amount (Transaction
Total)

{totalamount} DECODE({accounttype}, 'Expense', -1, 'Other Expense', -1, 'Cost of
Goods Sold', -1, 1) *{totalamount}

Saved Search Email
If you are an administrator or have at least Create level of the Publish Search permission, you can
enable system-generated search email messages on the Email subtab of a saved search page. The
saved search email function provides a powerful set of options that can serve multiple purposes.

You can use saved search email to share complete search results with other users, to schedule long-
running searches for low usage times, and to alert targeted users about changes to their important
records, and for specialized purposes such as drip marketing.

You can define whether to send saved search results email according to a regular schedule, as alerts
triggered by record adds or updates, or both. You can specify multiple recipients for both types of
email. Recipients can be indicated by user or group name, or derived based on search results field
values. For public saved searches, you can designate email alerts as available to users other than
specified recipients. You can customize email text and include search results embedded in messages or
as attached .csv or .xls files. (Note that CSV is the preferred format because it is the most compact.)

By default, each saved search email is sent from the search owner's email address. You can set a
different default as a company preference, and you can customize the email content for a saved search
to define a different sender.


